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1 Introduction

Welcome to the JBL Synthesis and DACS user guide. The below information is designed to help an installer use the SDEC and DACS
kit to properly test and calibrate a room. This guide is designed to help guide you through the calibration process when using the
original DACS Digital Acoustic Calibration System with the newly introduced SDEC-3000 and SDEC-4000 digital EQ systems.

NEED HELP? CALL...

If you encounter problems that cannot be resolved using the information presented here, please call your Synthesis Representative for
further assistance.

JBL Synthesis Technical Support (USA Only): 888.691.4171 Monday through Friday 9am-6pm Eastern Time Zone
Todd Packer: 516.682.6491
Ron Rouse: 916.451.0225
Chris Neumann: 818.895.5712
Dan Siefert (DACS problems only): 805.492.0773

SHIPPING THE DACS KIT TO THE NEXT DEALER

By the time you have completed your Client's installation, you should have received a FAX or email giving detailed shipping
instructions. If you have not received this information, please call immediately and request shipping information.
Unless otherwise instructed, always ship via UPS Blue.

When shipping, always insure kit for $15,000.00

2 Equipment Required:

PC with windows XP (Windows 2000 supported, for use with Windows 2000 the MDAC database components will need to be
downloaded from www.microsoft.com) and one Ethernet Network port. Windows Vista has not been tested as of the writing of this
manual.

= PC must have BSS Audio London Architect installed to access advanced features. Please contact JBL Synthesis
Technical Support for download instructions

= PC should be set to DHCP (default)

= PC may need to have Windows® firewall turned off

e 3 Standard Ethernet Network cables (for SDEC-4000). 2 Ethernet cables are needed for SDEC-3000.

e 4 port (or higher) Ethernet hub or router. JBL Synthesis has used the Linksys® brand of compact Wireless-G broadband Router
with good results. Four ports are required for use with the Harman Audio Test System (HATS™) system to be released in the
summer of 2008.

e DACS calibration kit. These are available from JBL Synthesis on a loaner basis. The kits are not for sale and are used by all our
dealers. Please contact Luisa Welsh at (818) 830-8757 to reserve your kit. The kit includes all additional tools you will need.
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3 Calibration Checklist

The calibration process is more than just measuring and applying EQ to achieve a preset target. It includes examining the entire signal
chain and confirming that all parts of the system are accurately connected. Use the below checklist to make sure you have completed
all the steps to ensure that your system meets the standards for the best audio system possible.

Follow this list in the order below and you will be guaranteed a great
sounding and properly calibrated JBL Synthesis installation.

v Speaker placement and installation is correct (page 16 - Speaker Sound Check)

v Correct connection from Preamp to EQ to Amplifier to Speakers (page 6 -

Audio Connections)

v" Connection of SDEC to Ethernet Network (page 8 - Ethernet Connection)
v Phase test of each speaker (page 16 - Speaker Phase Test)

v’ Set all preamp bass, treble, and speaker distances to flat or 0

v All bass management crossover points should be set to 80Hz. Do not use
80Hz THX® (See the SDP processor installation manual)

v Measure and input speaker offset correction (page 9 for Java Remote -
Distance/Delay settings or page 14 for London Architect - Channel Delay (Speaker Distance Offset
Correction)

v Use internal noise test and adjust SDP output levels to set nominal
reference level of 75dB using SPL meter before beginning room
correction EQ (page 18 - Setting Levels before Calibrating)

v" Set Processor to Dolby ProLogic and set volume to 0dB

v" Run room measurement using the DACS system and enter corrective EQ
settings (page 19 - DACS Measurement System)

v" Set final levels for system using SPL meter to balance overall output for
each speaker using gain adjustment in SDEC (page 15 - Level Matching Multiple

Surround and Subwoofer Channels)
v Use test DVD to confirm results using the subjective listening tests

v Save the SDEC settings file for backup to both your computer and the

network device (SDEC) for future recall (page 20 - Saving Your Work London
Architect software only)
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4 SDEC Hardware Connection

Please refer to the SDEC Installers Manual for detailed hardware connection instructions and diagrams. Check the SDEC for correct
connection using the below chart for SDEC-3000 and the next page for SDEC-4000 installations:

e Make sure you have access to the SDEC-3000 or SDEC-4000P and SDEC-4000X Ethernet port(s).

e Make sure you are using the correct interconnect kit, S3000IC or S4000IC.

¢ The system should pass audio and all channels should operate before beginning the calibration.

°

The SDEC-4000P and SDEC-4000X need to be connected to each other via the Cobranet® connection using a CAT5e crossover
network cable and must be a minimum of two feet (0.7 meter) long.

4.1 Audio Connections
SDEC-3000 7.1

Surround Processor to SDEC3000 Inputs

S3000IC SDEC3000
Number Channel Inputs

1 Left Front Al
Right Front A2

Center Front A3

Left Side A4

Right Side B1

Left Rear B2

Right Rear B3

Subwoofer

(Mono Sub LEFT) B4
SDEC3000 Outputs to Amplifiers
S3000IC SDEC3000
Number Channel Outputs
9 Left Front C1
10 Right Front Cc2
11 Center Front C3
12 Left Side C4
13 Right Side D1
14 Left Rear D2
15 Right Rear D3
16 Subwoofer D4

Figure 1.
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SDEC-4000 with SDEC-4000 with
Bi-Amplified Fronts Full-Range Fronts

Surround Processor to SDEC4000P Inputs Surround Processor to SDEC4000P Inputs
S4000IC S4000IC
Number Channel SDEC4000P Number Channel SDEC4000P

1 Left Front A1 1 Left Front A1
Right Front A2 Right Front A2

Center Front A3 Center Front A3
Left Side A4 || Left Side A4
Right Side B1 Right Side B1
Left Rear B2 Left Rear B2
Right Rear B3 Right Rear
Subwoofer (Mono Sub L) B4 Subwoofer (Mono Sub L)
N/C C1 || N/C
N/C c2 N/C
N/C C3 N/C
N/C C4 N/C

SDEC4000X Outputs to Amplifiers SDEC4000X Outputs to Amplifiers
$S4000IC $4000IC
Number Channel SDEC4000X Number Channel SDEC4000X

9 Left Front-Low Al 9 Left Front Al
Left Front -Hi A2 N/C A2

Right Front -Low A3 Right Front A3

Right Front -Hi A4 N/C A4

Center Front -Low B1 || Center Front B1

Center Front -Hi B2 N/C B2

Left Side 1 B3 Left Side 1 B3

Left Side 2 B4 Left Side 2 B4

N/C C1 N/C C1

N/C C2 || N/C C2

Right Side 1 C3 Right Side 1 C3

Right Side 2 C4 Right Side 2 C4

N/C D1 N/C D1

N/C D2 N/C D2

19 Left Rear D3 19 Left Rear D3
20 Right Rear D4 20 Right Rear D4

SDEC4000P Outputs to Amplifiers SDEC4000P Outputs to Amplifiers
S4000I1C S4000I1C
Number Channel SDEC4000P Number Channel SDEC4000P

21 Subwoofer 1 D1 21 Subwoofer 1 D1
22 Subwoofer 2 D2 22 Subwoofer 2 D2
23 Subwoofer 3 D3 23 Subwoofer 3 D3

24 Subwoofer 4 D4 24 Subwoofer 4 D4

Figure 2.
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-L- Local Area Connection Status

4.2 Ethernet Connection Genel] Suppot

For all SDEC-3000 installations you will need either a EoHeCtioniEtatle

crossover Ethernet cable or the SDEC will need to be .;'1! Address Type: Assigned by DHCP
connected to an Ethernet hub (figure 3). For all SDEC-4000 =5 I Address: 10161078
installations both the SDEC-4000P and SDEC-4000X, as well Subnet Mask 265.255.254.0

as your computer must be connected to an Ethernet hub and Deefauit Gatewsy: 10161032
on the same network (figure 4). :

NOTE: The below instructions assume you will be using an

. \N"indnw§ did nat detect problems with_ thie Repai
Ethernet hub or router. If you are using the SDEC-3000 you Eor e If you cannot cornest, ciick
can optionally use a crossover cable and not use a hub. '
o | T

Figure 5.

Connect the SDEC to an Ethernet router and plug in to AC
(there is no power button). The unit will boot up and acquire a
network address. This can be verified by watching the front
panel display. It will display the boot up message and then
scroll through product ID, Network Address and current time

J _ﬁ%?ss
aLsfzss

sgi=
23

Qi
el

m

g -

et
ik

L

i
7

o

3

Figure 4. SDEC-4000

4.2.1 Initial Network Connection

Plug router in to AC and make sure it is powered ON

Begin with PC OFF, SDEC UNPLUGGED (no power). Connect
PC to Ethernet router and boot PC. It should acquire a network
address. This can be verified in Start Menu > Control Panel
- Network Connections > Local Area Network > Support
Tab. Prior to getting the SDEC-3000 or 4000 On-line and
working turn it may be necessary to turn off your Windows
internet firewall on your computer so that you can talk to the
EQ (you do this from the “Control Panel”).
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5 Software Operation using the
Java Remote

The SDEC can be controlled and configured from any
computer that has access to the network via Ethernet. All
necessary features can be accessed and all system setup
parameters can be viewed and adjusted using the JAVA
remote but advanced features can only be accessed if using
London Architect to configure the SDEC. You must use
London Architect to access these additional settings. Functions
that cannot be done through the Java Remote include saving
backup copies of the calibrated file to your computer, saving
backup copies to the network device, seeing a graphic
representation of the EQ curve, creating multiple EQ presets
for different modes and recalling different EQ presets.

5.1 Using the JAVA Remote

After connecting the hardware as outlined in Section 4 SDEC

Hardware Connection, open the folder that contains the
Java Remote panel. Once you have opened the folder double
click on the correct file for your hardware you will be prompted
to enter the IP Address that appears on the front of the SDEC
display. Use the file with the same name as your hardware.
The file will end in a .JAR extension. This stands for JaVa
Remote.

JBL Synthesis - SDEC-3000 Control Panel: Enter IP ... [X]

Flease enter the 5 = IP add z nt panel

5.1.1 Speaker Setup Screen

Begin with the speaker setup screen and select the correct
speaker for your installation. This only needs to be done the
first time. In the future, or if you go offline and then re-connect
the pull downs will NOT show what you have selected but the

selections are still in memory.

SDEC-3000 Control Panel

3 >
Speals

PRTITSTS

5.1.2 Distance/Delay settings

Measure the distance from the center of the listening area (or
the “hot seat”) to each speaker location. The measurement is
accurate to less then one inch.

1B Synthpsks - SOFC. 3000 Cantaol Panel

SDEC-3000 Control Panel

Speaker Distance Front Left

s

m JBL Synthesis - SDEC-3000 Control Panel
SDEC-3000 Control Pan

Subwoofer EQ Subwoofer EQ

Click here to enter
the EQ settings

na

Click here to select
the correct channel

Type

to enter the EQ
settings

Click here to mute
the correct channels
during the DACS
test

parametric eq

ERinincsns
5.1.4 Channel Gain/Trim Adjust

Each channel should be adjusted to 75dB output after the
DACS test has been completed.

[EM JBL Synthesis - SDEC-3000 Control Panel

SDEC-3000 Control Panel

Channel Output Level and Phase Front Right
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6 Software Operation using
London Architect™

NOTE: While it is possible to use a WIFI access point to
control and configure the SDEC we do not recommend using
this method for initial setup when using London Architect. For
the most reliable connection it is highly recommended that you
use a wired connection.

6.1 London Architect” Software
Setup

If this is the first time you are using the London Architect™
Software you will need to open the IP properties and make
sure your computer is ready to connect to the SDEC.

Open the London Architect software from your Start menu >
All Programs. Go to Tools > Application Preferences >
HiQnet. Use Passive FTP should be checked and the correct
Network Interface Card should be checked. All other settings
should be left at the default

Application Preferences EJ

General Logging Start Up File FDS
Serial HiGnet Evert Log Colours

Check which interface cards you wish to use to configure and control
Hiynet devices, Changes will be applied on 'Ok,

[ os! AR Mini ard - P. B
[#]10.16.10.171 [Inkel{R) PRO/100 YE Mebwork Connection - Packet

Please choose the name of this computer

Use Hosk Mame

Use Passive FTP For better compatibility with firewalls

London Architect Preset Recall method. Change

orly if directed to by BSS Technical Support. Default ~

Meter Subscription Rate {in ms)
Fast Slow

Londan J
Defaulk 100ms

Cromn J
Default 200ms

Figure 6.

6.1.1 Network Control Panel

Open London Architect first. Make sure you are connected to
the same network and subnet as the SDEC. You should see
the unit(s) appear under the Network control panel listed within
the Ethernet node. If you cannot see the Network control panel
go to View—> Network. If you cannot see the unit(s) you should
first check all network settings and connections. Please check
the troubleshooting section for more details.

Dl Edt Vew Objst Zone Panel Galery logc System Took Window el _8x

BN N NN

e _— Y gl I

i Properties  ® X/ START PAGE |Dlain;100%,] J6L SDEC4000P - Ful Range LCR Corfigu.. | i

= al ~
Welcome to the SDEC 4000P/400f3—=— -

(Full Range or Biamped LCR'

View this Network panel
To control theforocessing objects in the SD!

the "Main" pAge which is usually displayed tO see the aﬁached
Colour  [] 220522 on the tab ghd then Double-Click on the upg deVICeS

il Type soid the SDEG/A000P on the page (it has all of th
up the désign page which shows the signal
* References objectg/you will use totune the system. Do

procgssing object to open it's control windd
othgr blue icon for the SDEC 4000X is used
and it does not have any tuning orlevel par:

fthe "Main" red tab is not found above then ySUTENMIRITCBY
following these steps:

1. Click on'the "'View" menu at the top of the window.
2 Ralact tha "Nacinn® view

5 99 Local (1)
=W PCE()
he

cowrkparkers
: ined Design Devices (3)
w0 BLUBOs (1)

® T BLUazs(1)

90 PCS (1)

] System Output | s Network [ [ Compler Report | @) Event Log
For Help, press F1 Operate. online. =Ee O 1ded

Figure 7.

6.2 Initial Software Connection to the
SDEC

If you are using SDEC-3000 or SDEC-4000 file version 1.0 of
higher the software will automatically attempt to connect. The
software automatically checks the hardware and updates any
of the following to the latest version.

e Firmware

e HiQnet Address

e Design configuration

e Parameter synchronization

NOTE: /f the Firmware or HiQnet address needs to be updated
the unit will need to be rebooted and the software will not be
able to automatically connect. In this case you will need to
manually select ONLINE. Please see the diagram below for
instructions.

i Hle Edt Vew Object Zone Panel Galery Llogc System Tools Window e -8 x

BN ST SN oL IR R

X START PAGE [Hiain ;1009 5L 5DECH030P - Ful Range LR Corigans | bl

Welcome to the SDEC 4000P/4000X Tuning Software
(B D - H iR

Object Na C1296

Click here to manually & Chronmusaclte
played abovelas a red tab. Click

select “ONLINE” mode the upper large blue icon for

. . jall of the inputd). That will open

and begin controlling the signal flow anfi processing
pm. Double-Cliqk oh each

SDEC-3000 or SDEC- e Hoe pasom o
s used for signal routing only

4000. vel parameters.

ve then you can fjnd it by

1. Click on'the "'"View" menu at the top of the window.

G[OTATE[E]] 5 satact the "Nacian visy

Sytem U] s Network [ 7 Cormplr Report | @0 v (o0 \ 4
o Ho, press £ G onine == O 1

Figure 8.

6.2.1 Open from a design file

Once you have confirmed that the unit(s) can be “seen” by the
software go to File> Open-> navigate to the proper design file
which will be an SDEC_xxxx .architect file. You should receive
it from JBL Synthesis Technical Support via e-mail. If you do
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not have the file you should be able to retrieve it from the
SDEC directly.

NOTE: To access the design file you will need a user name
and password
e User Login: JBL Synthesis Dealer

e  Password: synthesis _
Logon to Design

Please select you user name From the drop
down list

Admin |
Adimin

JBL Factory Rep

JBL Synthesis Dealer

[closeIExit l I Logon...

Figure 9.

6.2.2 Opening from a Network Device

The SDEC allows you to use the unused portion of memory as
a virtual hard drive. This space can be used to store copies of
the design file (as from the factory) or copies of your
customized design for the specific installation you are working
on... To do this select “File” then to “Open from Device
Network” instead of “File” and “Open”

Note: Check to make sure that you are using the most current
version of the control file. Please contact JBL Synthesis
Technical Support or your JBL Synthesis Representative for
the most current information.

6.2.3 Firmware Upgrade

If the firmware needs to be updated, check OK to proceed. The
unit may need to be rebooted. The software will check to make
sure the unit has the latest version automatically. You will
receive a message that “No Matched Devices” are found. This
is because the unit is being rebooted during firmware upgrade.
Wait for the unit to reboot and click Online as described
above.

6.2.4 HiQnet Node Address

If the below HiQnet node address message appears, click
NO. We want to maintain the address of the device in the
design, and then click OK. The device will be rebooted. You
will need to wait for the unit to reboot and click Online as
described above.

HiOnet London Architect

() The HiQnet node address of the device on the network does not match the node address of the device in vour
design.
LAY

You can choose to keep the node address of the device on the network {recommended),
or keep the node address of the device in the design {only recommended if you use external control).

Do you wish bo maintain the node address of the device on the network?

HiQnet London Architect

The node address of the device will be updated and the device
SV

[ pon't show me this message again

Figure 10.

6.2.5 Design Configuration

The design that the hardware has in its memory will be
checked against the design you have in your software. These
must match. If they do not match it will be necessary to have
the design updated. Please call your JBL Synthesis
Representative for instructions. It can be done in the field but
special instructions are needed. The Java remote does not
require and special login.
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6.3 ONLINE Mode

When in ONLINE mode you are actively controlling the SDEC-3000 or SDEC-4000. The SDEC-4000 can be configured for Full Range
(factory default) or Bi-amp mode. The SDEC-4000 is set to full range to ensure that the bi-amp speakers without built in crossovers will
not be damaged accidentally.

Use the below diagram to help you navigate the system while using the DACS measurement system to calibrate your room.

6.3.1 Speaker Configuration and Instructions

Begin here by selecting the appropriate speaker configuration. If you are using a bi-amp speaker such as in a Synthesis One Array
system, this will also enable the second output from the SDEC-4000

NOTE: You only need to the correct speaker configuration the FIRST TIME you connect to an SDEC. The SDEC will keep the last
setting in non-volatile memory until changed.

" SDEC-4000 4Fx

Left and Right Center Subwoofer

Sides Rears

Mok Listed v » Mok Listed v »

Select your speaker configuration
from the choices to the right

Refer to the SAM1HF/SAMZLF installation manual
for details about the different configurations possible

Left and Right Screen Center Screen

m ‘II Front Left I II Cenker I IIFront Rightl ‘m

@ Side Left 1 __, = Side Right 1
UTESOFF | —

Configl Configz Config3

[Ew] |[etez] = [sce gz
m ‘II Fear Left I II SUES I ‘IIRearRight I

&l ElEl

Begin with the SUBWOOFER. test and EQ first, after entering delays.
Any channel can be controlled by clicking the buttons to the left.

VSRSt i tOE NI Corkect { If you have questions please contact your JBL Synthesis factory
I Offline mfﬂﬁ lnu Mutes OFf S representative or JBL Synthesis Technical Support at:

888-691-4171 (USA Only).
= __ __

== =@ 111111

lic For Help, press Fl 2 Operate Orline ==a ) 100e
Figure 11.
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6.3.2 EQ Controls

Entering the EQ settings can be accomplished simply by clicking inside the boxes and typing in your settings. Any channel can be
accessed by selecting from the channel list on the left.

" SDEC-4000 - Center

Enter the EQ filter
ARG settings here
# UNMUTE the Subwoofer to test this channel

# MUTE all other channels not being tested

# Enter the corrective EQ by typing in the suggested
EQ settings after testing with the DACS measurement
system

= e :
BEypass All E

Frequency Boost,/Cut Bypass

Fronk Right

o [ [

UTESOFF |

[iw] |[etr] T B
m ‘II Rear Left I | SUBS ‘ilRear Right I

System Status f vaster Mute Control
I Offline NS OFF!‘ne | Jaimussoff v »
 TrimsePhase | e |
Illnstructions l ll Delays‘\ I ‘IEQ iyl vy |
| i

E EE E

ENEEEEEEEREER

CrEILILILILILILILILILNLD
CrLIAPAPLILALDALILILILNLD

o For Help, press F1 (] Operate Cnline . | '3 100e
Figure 12.
Click on the
channel button to
show the EQ
available
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6.3.3 Channel Delay (Speaker Distance Offset Correction)

Do not enter the distance measured into the channel distance box. Use the longest measured distance as your 0 reference and
SUBTRACT each speaker distance from this reference. This result is the number you should enter. For example: If the Left is 10 ft from
the primary listening seat and the center is 8 ft, you should enter 0 ft into the left (10 ft — 10 ft = 0ft) and 2 ft (10 ft — 8 ft =2 ft) into the
center.

Measuring and inputting the distance settings for each speaker is a simple process but is does require the installer to follow a simple
procedure. Failure to follow this procedure may result in incorrect settings being input in the EQ.
1. Measure the distance from each speaker to the central, or #1, microphone. This should be the center of the listening area
most likely.
2. Write down the distances for each speaker.
3. Using the longest measured distance subtract this from all the other distances.
4. Enter the result into each speaker distance.

e Measurements can be in Feet and Inches or Meters
When entering feet and inches use the format of XX’yy” where XX is feet and yy is inches. Use 0” if the distance is 0 different and
0’yy” if the distance is under 1 foot.

Note: When measuring and inputting the speaker distances into the SDEC DO NOT input the measured distances.

" SDEC-4000 - Delays

To calculate delays:

® Measure the distance from the center seat to each
speaker

@ Using the longest measured distance subtract this

number from each measurement

& Enter the result in for each channel

# The longest measured channel should be O

# The measurement can be entered in feet and inches by
entering xx’yy” (for example 5°7")

® The SDEC will calculate the milliseconds delay

! — — —
IEM' |’| Fronk Left I ‘ll Certer I ‘ilFront Rightl |

— Type in the correct distance

E offset in this box. Enter as feet
E and inches or meters and the
* correct millisecond delay will
be calculated
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i
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=)

System Status Master Mute Control
| offine 1! 5o offiine | {8 Mutes Off v »
EQ Bypass
Inskruckions I —i iEQ i v B
» For Help, press F1 2 Operate Orline s 100e

Figure 13.
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6.3.4 Channel Output

Use each output to adjust each channel to give the same output level using an SPL meter.

6.3.5 Level Matching Multiple Surround and Subwoofer Channels

The SDEC-4000 has multiple outputs for Subwoofers and Side Surrounds. These will need to be level matched to each other before

final output levels are set.

1. Using the internal noise test of the SDP test each output individually. It will be necessary to mute the output you are not testing.
Make sure the Trim Link is off (not RED).

2. Once you have set each to the reference level (75dB) enable the Trim Link feature so that the led turns RED.

3. With all the multiple channels un-muted test together and adjust the output to reach the same reference level. You will now have an
output that has all the multiple channels level matched and the overall output set to the reference level.

~ SDEC-4000 - Trims q kX

Master

# Yhen all channels are completed UNMUTE all outputs
and set final output levels in the surround processor
using an SPL meter. Set to reference level of 75dB, slow el Sl Sl 10- | ~-10

response and “C” weighting

# Test each speaker for proper Phase by using the
Cricket Sender/Receiver included in the DACS kit

# Phase is reversed when the LED is on

|l|Fr0nt LeFtT ll Cenker I iIFront Rightl

i
{ |
|

bl

I MUTES u:r

||

—— Les
|l| Rear LeFtT {7 ses | | |IRearright |
|

|Side Right 2
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i

| Side Left 2

BREIERE

System Status Master Mute Control

RR .-

|
I
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Figure 14.
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7 Speaker Sound Check

Use the circulating noise generator of the Surround Processor
to confirm that all channels have output and that each speaker
is connected to its corresponding channel.

8 Speaker Phase Test

This procedure uses the Surround Processor to route the
phase tester's output to the appropriate channel for test. Using
a "Y" adapter, connect the phase tester's output to both
channels of the TAPE or AUX input or any available analog
input. Select the input making sure that the processor is set to
the analog input you have selected, use the Surround
Processor's volume control to set the test level. Select PARTY
or 5/7 Channel Stereo Mode to route the test signal to all
speakers. It may be necessary to adjust the volume or mute
certain channels to get a clear and accurate test result.

8.1 Main Speakers

Use the phase tester to confirm the following driver polarities of
the L-C-R and subwoofers

Synthesis Everest:
L-C-R UHF (+)

L-C-R Horns (+)

L-C-R Mid-bass drivers (+)
Subwoofers (+)

Synthesis K2 S9800:
L-C-R UHF (+)

L-C-R Horns (-)

L-C-R Mid-bass drivers (+)
Subwoofers (+)

Synthesis Atlas SK2-1000:
L-C-R UHF (+)

L-C-R Horns ()

L-C-R Mid-bass drivers (+)
Subwoofers (+)

Synthesis One Array:
L-C-R UHF (-)

L-C-R Horns (+)

L-C-R Mid-bass drivers (+)
Subwoofers (+)

Synthesis Two Array:
L-C-R UHF (-)

L-C-R Horns (+)

L-C-R Mid-bass drivers (+)
Subwoofers (+)

Synthesis Array Three:
L-C-R UHF (-)

L-C-R Horns (+)

L-C-R Mid-bass drivers (+)
Subwoofers (+)

Synthesis Four:
L-C-R Tweeters (-)

L-C-R Mid-range (-)

L-C-R Mid-bass drivers (+)
Subwoofers (+)

Synthesis Project Array:
(except Array 880)

L-R UHF (+)

L-R Horns (+)

L-R Mid-bass drivers (+)
Subwoofers (+)

Array 880

C UHF (-)

C HF (+)

C Mid-bass drivers (+)

8.2 Surround Speakers

8.2.1 S4Ai configured as Bipole (default)

The S4Ai can be used as a bipole, dipole or a direct radiating
point source speaker. The default as shipped is bipole. Other
bipole speakers would be similar.

® |

e R
& B P B

Figure 15.
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8.2.2 Dipole Surrounds

Regardless of model there is one standard for phase
configuration of Dipole surrounds.

- e

&

Figure 16.

8.2.3 Direct Radiating Point Source
Surrounds

B ke

|

Figure 17.

8.3 Using the Phase Tester

The Galaxy Audio phase tester consists of two battery
operated instruments, Cricket-S is the "sender", and Cricket-R
is the "receiver".

8.3.1 Cricket-S

The sender generates a short duration, positive polarity pulse.
This is applied to the power amplifier input which drives the
loudspeaker being tested. Coincident with the generation of
each pulse, a green LED is illuminated. Three output
connectors are located on the rear panel. Line level male XLR,
line level female 4" phone jack and a speaker level female V4"
phone jack. A female XLR to RCA adapter cable is provided in
the kit. Plug this cable into the XLR connector and use it to
connect the sender to each channel for test. On the front panel

are two slide switches and a pulse indicating LED. Slide the
ON/OFF switch to the ON position and the output selector to
the LO position. You should now hear pops at one second
intervals from the speaker under test. If a higher level is
required, set the output selector to HI.

8.3.2 Cricket-R

The receiver contains a microphone and phase analysis
circuitry. Positive polarity is indicated by a green LED, negative
by a red LED. Two input connectors and the microphone are
located on the rear panel. There is also a switch marked
"CON" (continuity) and "POL" (polarity). Place this switch in the
"POL" position. On the front panel are two slide switches, a
rotary gain control and the two phase indicating LEDs. Slide
the right side switch to the ON position and place the left side
switch in the MIC position. Now move the receiver’s
microphone toward the speaker being tested. W hen you are
within three to six inches of the speaker you should begin to
see a polarity indication. Adjust the gain control until a
consistent indication of phase is realized.

SPK

== GALAXY 2
AUDl)éY

CRICKET§
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9 Setting Output Level

9.1 Setting Levels before Calibrating

Using the internal noise generator of the SDP set all outputs to
achieve 75dB using the “C” weighting and “SLOW” response.
This will maintain the best signal to noise and headroom
possible by optimizing the gain structure of the system.

9.2 Final Level Set after Calibrating

Setting the final output level should be done after all corrective
EQ has been completed. It is very important that this be done
so that all channels have a good balance and are properly
calibrated for the average output in the mid-band frequencies.
Use the internal noise test from the SDP and test one channel
at a time.

e Set main and surround channels to 75db.
e Set the subwoofer channel to average between 82dB-
85dB.

9.2.1 Level Matching Multiple Surround
and Subwoofer Channels

The SDEC-4000 has multiple outputs for Subwoofers and Side
Surrounds. These will need to be level matched to each other
before final output levels are set.

1. Using the internal noise test of the SDP test each output
individually. It will be necessary to mute the output you are
not testing. Make sure the Trim Link is off (not RED).

2. Once you have set each to the reference level of 75dB
enable the Trim Link feature so that the led turns RED.

3. With all the multiple channels un-muted test together and
adjust the output to reach the same reference level. You
will now have an output that has all the multiple channels
level matched and the overall output set to the reference
level. Follow the instructions for level matching the
multiple surrounds and subwoofer channels first and then
set the overall output level to the following reference level.

9.3 Using the SPL Meter

9.3.1 Analog SLM Instructions

NOTE: All instruments of this type are most accurate when
operated in the upper end of the selected range. You should
always use the lowest RANGE setting possible. For example, if
you are balancing a system using the Surround Processor's
noise generator (75dB) you would set the RANGE selector to
70dB.

1. Rotate the RANGE Selector clockwise one click to the
BATTERY TEST position. Observe the meter indication. A
reading anywhere within the red BATT TEST range
indicates adequate battery power. If the indication is below
this range, replace the battery before using the instrument.

2. Now rotate the RANGE Selector clockwise to the desired
range. The meter has a display range from -10dB to +6dB.
The 0dB point corresponds to the RANGE selected.
Therefore, if the 80dB RANGE is selected, a 0dB reading
will equal 80dB.

3. Slide the WEIGHTING Selector to "C" weighting for
channel balance tests. "A" weighting cuts low frequencies.
This will cause errors when measuring subwoofers.

4. ltis recommended that you slide the RESPONSE Selector
to the SLOW position. This slows the meters response to
sudden changes in sound level which can make average
level readings difficult.

RANGE Beleclor

RESPONSE Delactnr

WEIGHTING
Selesior

Whestar

9.3.2 Digital SLM Instructions

NOTE: All instruments of this type are most accurate when
operated in the upper end of the selected range. You should
always use the lowest RANGE setting possible. For example, if
you are balancing a system using the Surround Processor's
noise generator (75dB) you would set the RANGE selector to
70dB. In the event you have selected a range that is too low,
an OVER-RANGE condition is indicated by a flashing display.
Select the next higher range.

1. Turn the SLM on by rotating the RANGE Selector
clockwise. Continue to rotate the RANGE Selector to the
desired RANGE.

2. Press the WEIGHTING button to select "C" weighting for
channel balance tests.

3. Itis recommended that you slide the RESPONSE
Selector to the SLOW position. This slows the meters
response to sudden changes in sound level which can
make average level readings difficult.

4. Check the display for a low battery indication. If the battery
needs replacing, BATT will appear in the upper left-hand
corner of the LCD display. Replace the battery if
necessary.

|| | PanGE -
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10 DACS Measurement System
10.1DACS Hardware Setup

Unpack the DACS Kit and setup the microphone array. Make
all standard connections except for connecting to the SDEC.
Use the below diagram as a guide.

Note: Please refer to the DACS manual that comes
with the DACS Kit for detailed instructions.

PLACE MIC 1 AT

FRIMARY POSITION EVP-1 FRONT LAPTOP COMPUTER

FRINTER COMPUTER
T

TAFE FWIR CTL
I DE@E DR E @EE 2

[ololololelolofololo)e

Figure 18.

10.2Channel Test and System
Calibration

Use the DACS to test the channels one at a time, to make
suggestions for filter settings. When using the DACS computer
the basic workflow is as follows:

Make sure you have set the processor to Dolby Pro Logic
and the volume is at 0dB.

e Inthe DACS computer you will press F2 (TEST) to test
and check level

e Press F4 (AUTO EQ) to test and allow the DACS to
suggest EQ settings

e When each channel is done you can press F5 (NEXT) to
go to the next channel to test

e Use the London Architect software to mute the channels
you are not working on and to input EQ filter settings.

e When testing the rear channels you will use the “Ambient
L or Ambient R” channels in the DACS. These channels
will be used for both the SIDES and REARS. Simply mute
the unused channel from within the London Architect
Software. It is best to test the Left Side and then the Right

Side before testing the Left Rear and Right Rear channels.

Use the System Control to select channels and use the matrix
to mute the channel “on” and “off”, don't forget to “un-mute” all
at the end.

e You will start by MUTING all channels except the Sub-
Woofer.

e Once you have tested and calibrated the Subwoofer you
will un-mute only the channel you are working PLUS the
subwoofer.

e Test the Side and Rear speakers with the Subwoofer
Muted.

Test each channel using the DACS calibration kit and copy EQ
filter suggestions from DACS to London Architect. It will be
necessary to test each channel using the DACS. If you use F4
the DACS will test and suggest filters to use. Copy these filters
for each channel.

Note: The DACS may suggest more filters than you have
available. In this case you will need to decide what filters
are necessary and audible. In general the filters than
suggest under 1db of change can be ignored.

Click on the
box and type
in the value

AEEEEEERREEEE

Figure 19.

As you copy the filter EQ setting from the DACS to the London
Architect you will see the resulting EQ curve. If you are using
the web interface (Java Remote) you will not see the EQ curve
display. This is normal.
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10.2.1 Parametric Filter Values

Parametric Filter Values

Octave Width
Fractions Decimals
112 0.08
1/10 0.10
1/9 0.11
1/8 0.13
1/7 0.14
1/6 0.17
1/5 0.20
1/4 0.25
1/3 0.33
2/5 0.40
3/7 0.43
4/9 0.44
1/2 0.50
4/7 0.57
2/3 0.67
3/4 0.75
7/8 0.88
1 1.00
Figure 20.

11 Saving Your Work

12 Recalling Saved Settings

The SDEC-3000 and SDEC-4000 DO NOT REQUIRE that you
save at any time. When you are online and operating the unit
your settings are being stored in protected memory at all times
and no save process is required or possible. Saving your work
is completely a safety copy in case anything happens to either
the SDEC or your computer.

Once you have completed the calibration and the final
subjective listening tests you can save your work. Two copies
should be saved. The first is a copy on your computer that you
can distribute to other installers or keep as a backup on your
own computer incase anything happens to the SDEC. The
second is a copy that will be kept on the SDEC itself that can
be retrieved in case your copy becomes corrupted or lost.

11.18Save a copy using SAVE AS

Once finished but still connected to the Ethernet Network go
OFFLINE by clicking on the green check box labeled ONLINE.
This will disconnect your software from actively controlling the
unit. It is now possible to use Save As from the File menu and
save a copy as any other Windows file can be saved.

11.2Save to Network Device

Once finished but still connected to the Ethernet Network go
OFFLINE by clicking on the green check box labeled ONLINE.
This will disconnect your software from actively controlling the
unit. You must first save the file to your computer using
SAVE AS and name it a unique name for this install. It is
now possible to use Save To Device Network from the File
menu and save a copy to the SDEC itself. This can be
retrieved by using the Open from Device Network menu
explained below.

Recalling your settings assumes that you are using London
Architect to open and control the SDEC. If you are using the
web interface (version 1.01 of the design file or higher) you will
not need to recall settings as the settings will automatically be
recalled. Settings can be retrieved from a number of different
ways. Please read below for the different options. The London
Architect software will automatically check to match the
settings in your software against the hardware and give you
options when opening the file and going online.

Note: If you do not have a copy of the saved file and
cannot recall from the device network DO NOT update the
design file. You MUST have the same design file that was
used to calibrate the system, even if it is not the saved file.
Please contact JBL Synthesis Tech Support for more
information if you have this problem.

12.1Recalling from a Saved File

If you have the saved file from the London Architect software
you can simply open it with London Architect and you will now
have the same settings as before.

12.2 Recalling without a Saved File

You must have a copy of the same design file that you
originally used to do the calibration, even if you have not a
saved copy. This is the same file that is saved in the SDEC but
all the settings are flat with no EQ or calibration settings saved.
This is the file you would have received from JBL Synthesis or
opened from the device network originally. Using this “blank”
file to connect to the SDEC. When you first go online you will
be prompted to select from synchronizing the settings from
your computer software or synchronizing from the hardware
device. Choosing hardware device will recall all the settings
from the hardware and show them in the software on your
computer.

12.3Recalling from Network Device

If a copy of the file has been saved to the SDEC itself it can be
recalled from the device. After opening the London Architect
software go to File> Open from Network Device. You will be
prompted for a password and user login if necessary and
shown a list of available files to open.
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13 Advanced Features

13.1Cinema/Music Subwoofer Output

The SDEC has the ability to change the subwoofer output gain
to accommodate both the standard cinema curve and a more
linear music output level. This feature has been built into the
SDEC as a simple alternative to the multiple EQ presets that
would otherwise be necessary as described in Section 13.2
Multiple EQ Presets. Changing the output level of the
subwoofer using this preset will not have an effect on your
standard calibration. The default setting is Cinema with no
change to the output level. The preset can be triggered in three
ways: (1) via RS232; (2) via Ethernet; (3) via the contact
closure trigger on the rear panel.

Note: You must have SDEC3000/SDEC4000 version 1.10 or
higher for this feature.

13.1.1 RS232 Settings

Cable Type: Null Modem
DB9 Female — PC DB9 Female — SDEC
TXPIN 3 RX PIN 3
RXPIN 2 TXPIN 2
GROUND PIN 5 GROUND PIN 5
Serial Port Settings: 8 Bit

No Parity

115200 bps

No Flow Control
Command acknowledgment will be sent within 1 second from
when the command was sent. If no ACK is received then the
command should be resent.

13.1.2 Ethernet Settings

Cable Type: Standard Ethernet network
Ethernet Port Settings: TCP PORT 1023

13.1.3 Command Strings

The command strings are the same for both RS232 and
Ethernet protocols.

Model Command String
Cinema Level — 0dB Default level
02, 88, 50, 79, 1B, 83, 00, 01, 14, 00, 00, 00,
00, 00, 00, B7, 03

SDEC-3000 Music Level - 2.5dB
02, 88, 50, 79, 1B, 83, 00, 01, 14, 00, 00, FF,
FF, 9E, 58, 71, 03
Cinema Level — 0dB Default level
02, 88, 13, 86, 1B, 83, 01, 01, 30, 00, 00, 00,
00, 00, 00, 2E, 03

SDEC-4000 Music Level - 2.5dB
02, 88, 13, 86, 1B, 83, 01, 01, 30, 00, 00, FF,
FF, 9E, 58, E8, 03

13.14 Contact Closure Trigger

Using the rear panel connections labeled “Control Inputs”
connect a contact closure between input (top row) #4 and the
connection labeled “C” (for common). When the contact is

normally open the default setting of 0dB will be active. When
the contact is closed the -2.5dB setting will be triggered.

13.2Multiple EQ Presets

Up to two EQ presets can be stored and recalled. All channels
can be changed and are saved and recalled together. Due to
the advanced nature of this process it should only be done
under the supervision of JBL Synthesis factory personnel.

13.2.1 Saving Presets

Please contact JBL Synthesis Technical support for this
feature. It requires advanced training and the use of London
Architect. It cannot be used with the Java Remote. As this
feature is considered an advanced feature there is the
possibility of loosing your work if you do not have the proper
training. Due to this possibility JBL Synthesis is not releasing
the information except to qualified personnel who have
undergone advanced training with JBL Synthesis personnel.

13.2.2 Recalling Presets

Presets can be recalled using several methods. The presets
can be triggered via RS232, Ethernet or while online with
London Architect. Due to the danger of accidentally erasing or
deleting your active EQ settings JBL Synthesis is not releasing
the information except to qualified personnel who have
undergone advanced training with JBL Synthesis personnel.

13.3Parameter Synchronization

Note: This procedure can only be done if changes are
made to the Design File preferences. This will allow you to
take saved settings and place them into a new unit. The
only reason to do this is if the old unit is defective and
needs to be replaced. Do not do this unless directed by
JBL Synthesis Personnel.

If both the hardware and the software have the same version
of the control and design configuration then the software will
check to see of the settings and parameters match. If they do
not match you will be given the option to synchronize the
settings. You will be prompted to tell the software whether you
want to use the settings from your computer, or load the
settings from the hardware. If you are starting a new calibration
or want to replace what is set in the EQ with your settings from
the computer, select update from software. If you have already
begun the process and want to continue your work, or use the
settings in the EQ as a starting point, then select update from
hardware. Select the green arrow to send your values from
your saved file or select the red arrow to receive the values
from the hardware. The unit name will highlight in green when
done. Click OK to continue.
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14 Troubleshooting Guide

Symptom

Probable Cause

Solution

Cannot see the units in the Network
control panel

“No Matched Devices Found”

Cannot save settings

No Audio

“You do not have sufficient rights
to load this design”

Wrong network card selected

Ethernet cable unplugged

Wrong network card selected

Ethernet cable unplugged

Device default name changed

Cannot save while online
No Input
Wrong Outputs Used

Cobranet not connected (SDEC-
4000 only)

SDEC needs to be updated

Attempting to change HiQnet
address

Attempting to load a newer version
of the software into the SDEC

Check IP properties in application
preferences

Check connections

Check IP properties in application
preferences

Check connections

Use “Auto Match Devices” to
reconfigure

Go offline first

Check connections

Check pre-amp or source

Check connections

Check Cobranet connections

Use London Architect to update

Close the project and reopen. When
prompted if you want to change
HiQnet address select NO.

Call your JBL Synthesis
representative or JBL Synthesis
technical support for the proper
password.

Use the Java Remote
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JbL,

Harman Consumer Group, Inc.
250 Crossways Park Drive
Woodbury, NY 11797

8500 Balboa Boulevard
Morthridge, CA 91329
818.830.8757

www. jblsynthesis.com

H A Harman International Company
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